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This publication provides basic information about maps and a step-by-step instruction for producing two types 
of census data maps applicable to any community.  It is assumed that the reader has access to census data.  If the 
reader needs guidance on how to access Census data, please see the author’s previous publication: “Accessing 
and Visualizing Census Data Using ArcGIS”, Perspectives on Planning, 7 (1), which can be accessed at: 
http://www.urpl.wisc.edu/people/gocmen/publications/index.html (within “Perspectives on Planning” 
subheading).   
 
Some Basics about Maps 
 
Maps differ based on their intended goals.  “Reference maps” are maps that display places of interest.  County 
road maps are one very common example of reference maps.  “Thematic maps,” instead, display a geographic 
phenomenon, in other words, a theme.  When maps displaying census data are made, a thematic map is typically 
created to display socio-economic phenomenon in communities, regions, or the nation.   
 
A thematic map created with GIS depends significantly on several factors including the type of geographic 
feature represented and how data were measured.  Below you will find brief explanations of these two factors 
and how they influence map creation. 
 
Some Basics about Representation of Geographic Data in GIS   
 
In GIS, geographic features can be represented in multiple ways.  Three of these representations are very 
common: points, lines, and polygons.  “Points” refer to any features that can be represented in one dimension 
such as fire hydrants, trees, and electric poles.  “Lines” refer to a two-dimensional geographic feature that has a 
linear characteristic.  Line features include streets, contour lines, and sewer lines.  “Polygons” are also two-
dimensional, but they encompass an area.  Political jurisdictions and land use are examples for polygon 
features, and so is the census tracts layer that we will work with in this publication.  You will notice that certain 
geographic features can be represented as one or the other type.  For instance, a city can be represented by a 
point or a polygon, mostly dependent on the scale of the map.   
 
 
 
 

http://www.urpl.wisc.edu/people/gocmen/publications/index.html


Some Basics about Level of Measurement and Map Design 
 
Geographic data could have a nominal (i.e., qualitative) or quantitative level of measurement.  While both 
nominal and quantitative data can be displayed using a thematic map, the display of quantitative data differs 
from nominal in a significant way: quantitative measurements can be displayed using a color-coded thematic 
map called a “choropleth” map that displays the values of quantitative measurement in a sequence.  With 
nominal measurement, that is not possible as the values cannot be compared; one value cannot be lower or 
higher than the other one from an analytical perspective.  A thematic map using nominal data might, for 
instance, display Republican and Democrat states.  A similar map, which displays the percentage of Republican 
votes in each state would make use of quantitative data and also possibly a sequence of colors to indicate an 
order of most Republican to least Republican states.   
 
Further, it is possible to visualize quantitative measurements for aerial units (i.e., polygon layers) in maps other 
than a choropleth.  These include dot density, graduated symbol, isopleth, stepped-surface, 3D surface / 
perspective maps and cartograms.  For further information on different types of maps (and map design), please 
see:  

 Dent, B. D. 1999.  Cartography: Thematic Map Design (5th ed.).  McGraw-Hill Publishers. 
 Robinson, A. H, Morrison, J. L., Muehrcke, P. C., Kimerling, A. J., & Guptill, S. C.  1995.  Elements of 

Cartography (6th edition).  John Wiley & Sons, Hoboken. 
 Cuff, D. J. & Maltson, M. T.  1982.  Thematic Maps: Their Design and Production.  Methuen, New 

York. 
 
In this publication, we will concentrate on two types of maps: dot density and choropleth.  The principle behind 
dot density maps is to display approximate quantities of a geographic phenomenon as dots within an area.  For 
instance, we can display the total population within census tracts in dots, where each dot represents a certain 
number of people within that census tract.  Choropleth maps, on the other hand, are maps showing shaded areas 
of quantitative data based on different classes.  Differences among classes in a choropleth map, a topic that will 
be covered in more detail in the next publication, are established based on the number of classes and the method 
of classification.  If we were to consider the same variable (i.e., total population), the choropleth map would be 
a map of census tracts, all shaded using a range of colors based on the breakdown of population within each 
census tract.   
 
Now, let us create and work with a dot density and a choropleth map to display female population in Dane 
County.   
 
Creating and Modifying Choropleth Maps Using Census Data  
 
To get started, launch ArcMap, add the Dane County census tract layer, and make sure the demographic data for 
census tracts is saved.  (If you do not see the demographic data, you will have to join the attribute and spatial 
data again.  The step-by-step directions from the previous publication “Accessing and Visualizing Census Data 
Using ArcGIS” will let you “join” the demographic data to the census tract boundaries.)  You will remember 
that in fact you have already created a choropleth map after following the steps provided in the previous 
publication.  Thus, steps 2-6 will be familiar to you.  Nevertheless, the steps below will incorporate additional 
tools for choropleth maps.    
 

1. In order to ensure that the “join” of demographic data undertaken during the previous publication is 
saved, create a “layer” out of the census tract “shapefile”.  In GIS terminology, a layer is “a separate 
categorical entity” and contains both spatial and attribute data.  Thus, census tracts, roads, and rivers that 
make up a GIS map, would all be different layers.  In ArcGIS terminology, it has a specific and 



technical meaning as well.  A layer could be a shapefile saved as a “.lyr” file in ArcGIS (if needed, 
please refer to the previous publication for the definition of a “shapefile”).  Each time that a layer (.lyr) 
file is brought into ArcMap, it will retain the conditions it had during when it was saved.  For instance, a 
layer retains the displays (e.g., different shadings) and also the “joins” performed on the original 
shapefile.  The way to create a .lyr file is to right click on the layer (in this case “tgr55025trt00”) and 
select “Save as Layer File”.  You could name it “danecocensustract”.  Make sure that you save the .lyr 
file in the same file folder as the original shape file.  Saving all supporting files in the same file folder 
will ensure the proper functioning of the layer. 

2. Right click on the layer “danecocensustract” and click on “Properties.” 
3. Click on the “Symbology” tab. 
4. On the left, under “Show:” select “Quantities” and then “Graduated colors.”   
5. In “Fields”, for “Value”, select “tgr55000sf1trt.FEMALES” (it is possible that you may just see 

“FEMALES” as the attribute).   
6. Click “OK.”  By clicking “OK”, you have accepted the default options of the color schemes, a five-class 

breakdown, and the “Jenks / Natural Breaks” classification method.   
7. By going back to “Properties” and “Symbology” (steps 2 and 3), you can change these properties.  In 

order to change the color scheme, click “Color Ramp” pulldown menu and select the desired color 
scheme.  If you want to observe the changes right away, you can click “OK.”  Otherwise, continue with 
the following step. 

8. (If you have already accepted the changes, please go back to “Properties” again in order to change the 
number of classes.)  Select the desired number of classes by adjusting (the number of) “Classes” inside 
the “Classification” section.  If you want to observe the changes right away, you can click “OK”.  
Otherwise, continue with the following steps.   

9. The default classification is the “Jenks method”.  This method classifies the data according to the natural 
groupings of the data.  Large breaks in the quantitative data or outliers can easily be captured with this 
method.  In order to change the classification to a different method, click on “Classify.”  This 
classification panel allows you not only to change the method of classification, but also to view 
classification statistics and modify the classification (e.g., by excluding certain values such as outliers 
from the classification).  For now, let us focus on the method of classification.  By clicking on the 
“Method” pulldown menu, you can change the method of classification.  We will discuss the implication 
of each classification method in the following publication.  For now, select the “Quantile” method and 
click “OK” to go back to the “Properties” window and click “Apply” and “OK” again to view the 
changes you have made.   

10. If you are familiar with Dane County, you will notice that Lake Mendota and Lake Monona appear to 
have a “female” population within them.  That is because we have not excluded “no population” areas 
from our display.  In order to exclude these census tracts, go back to “Properties”, and select “Classify.”  
Then, click on “Exclusion.”  This will open another panel, in which exclusion of values based on a 
logical statement is possible.  Double-click “tgr55000sf1trt.POP2000” in the “Exclude Clause” list, click 
on the “equals” sign, and type 0 (you could just type this directly as well).  To ensure that you have 
written the statement correctly, check that the statement within the white area reads as: 
“tgr55000sf1trt.POP2000” = 0  This statement will allow us to select all census tracts that do not 
accommodate any population, and exclude them from the display. 

11. Click “OK” to exit the Data Exclusion Properties window, then click “OK” again to exit the 
Classification window, and then click “OK” for the last time to exit the Properties window.  You will 
notice that the census tracts with no population are now displayed as blank.  For Dane County, that is 
where Lake Mendota and Lake Monona are. 

12. The total number of females or the proportion of females to that of males may be useful for different 
purposes such as placing new social services or retail stores.  In order to display the proportions rather 
than the whole populations, we need to “normalize” the quantitative data.  Normalization can also be 



done within the “Properties” panel.  In the Layer Properties panel, select the “Symbology” tab, click on 
the “Normalization” arrow in the “Fields” section, and select “tgr55000sf1trt.MALES” (in case you 
have a different display, you may need to select MALES).  This will display the proportion of females to 
males within each census tract.  Click “OK” and examine the modified map (Figure 1). 

 
Figure 1: Female to Male Population Ratio by Census Tract in Dane County in 2000 
(based on a four-class breakdown using the quantile classification method) 
 

 
 
 
Creating Dot Density Maps Using Census Data 
 
The following steps show how to display the total number of females in each census tract as a dot density map. 

1. Open the Dane County census tracts layer properties panel.  Select Symbology, and Quantities (steps 2 
to 4 above).  This time, instead of selecting “Graduated colors”, select “Dot density” from the options 
available under “Quantities.” 

2. From the “Field Selection” list, select the variable that shows the total female population in the census 
tracts (tgr55000sf1trt.FEMALES).  Once the attribute is highlighted, click on “>” and notice that the 
attribute and a symbol are displayed in the white space.   

3. Click “OK” to accept the default settings, where one dot represents 60 females.  Now, you can view a 
different type of map (Figure 2).  

4. If you want to display a different dot size, dot color, or number of female populations represented by 
each dot, you can do this within “Symbology” tab in the layer properties panel.  You can change: 

 the color of the dots by clicking the default color ramp menu 
 the dot size by typing in the desired value in “Dot Size” 
 the number of females by typing in the desired female population in “Dot Value”   

Note that there are other options you may want to experiment with.  These include adding additional 
variables in the display.   
 



Figure 2: Female Population in Dane County in 2000 
(based on census tracts, where each dot represents 500 females)  
 

 
 
A crucial point to remember with both choropleth and dot density maps is that the distribution of values is based 
on zones (census tracts) where the values are aggregated.  In other words, in the choropleth map, the entire 
census tract will be colored even if parts of it may not be occupied by population of interest or any population at 
all.  Similarly, in the dot density map, the locations of the dots do not indicate the location of population of 
interest within the census tracts.  The dots are placed randomly.  Indeed, you will notice that the location of dots 
within the census tracts will change even if you only change the color for the dots.   
 
Creating Layouts (Maps to Print or Incorporate with Other Documents) 
 
If you want to use these maps in presentations or reports, you may have already noticed that you need to do 
some extra work.  Right now, we can not display the map image with a legend or crucial cartographic elements 
such as the north arrow and scale bar.  In order to add such useful information, we need to create a layout.  The 
following steps will guide you in this respect: 

1. Click on the “View” pulldown menu and select “Layout View.”  This will display your map on an actual 
page with default settings (A4 page size with portrait orientation).  If you wish to change the location or 
size of the map view, click on it and then move the highlighted box. 

2. In order to add a legend, select “Legend” from the “Insert” pulldown menu.  In the “Legend Wizard”, 
you will notice that census tracts layer is already highlighted as a Map Layer and already transferred as a 
Legend Item.  Click “Next” to accept the display of the census tracts layer in the legend and also the 
default options and continue to click “next” until the legend panel is gone (if you wish to change the 
default settings for any particular item, you could do that in between).  Once you accept the default 
options, you will notice that the legend will have useful, yet not meaningful information for your 
audience.  For instance, it will have “1 Dot = 500” which, as you know, indicates the number of females 
that each dot represents.  Yet, your audience will not necessarily understand that.  Similarly, the legend 
will display a dot for tgr55000sf1trt.FEMALES (the attribute and the source file) but that will not be 



meaningful to the map reader either.  In order to eliminate the vague and technical information, select 
the legend by clicking on it.  Once there is a dotted box around it, right click and select “Convert to 
Graphics”.  Then, right-click on the item you want to modify and select “Ungroup”.  You will need to 
“Ungroup” again, as the graphic and text portion of each legend item will still be grouped together.  
Once completely “ungrouped”, you will be able to modify each of the legend items.  By double clicking 
on any particular item, you are able to change the text (or properties of the text), move or even delete the 
item.       

3. In order to add a north arrow, select “North Arrow” within the “Insert” pulldown menu.  Once you select 
the desired type of north arrow, you can change the specifications by right-clicking the north arrow to 
open the “Properties” panel. 

4. In order to add a scale bar, select “Scale Bar” within the “Insert” pulldown menu.  Again, you can 
change the specifications of the scale bar within the “Properties” panel of the scale bar graphic (right-
click the scale bar to open it).  An important specification for a scale bar is the “distance units”.  When 
displaying a county map, it is not easy to interpret small units such as feet and meters; thus, it is more 
appropriate to use miles or kilometers.  The default option (decimal degrees) should also be avoided as it 
is another difficult unit to interpret.  An additional point to consider is the accuracy of these units in 
general, which is impacted by the map’s “projection”, a topic we have not discussed yet.  In general, you 
should remember that without projecting any spatial data using a location-specific projection, you will 
encounter some inaccuracies with respect to shapes / angles, distances, or aerial calculations.    

5. With the same steps, you could add other items such as a title and an image.  Once you add all necessary 
elements, you can move or resize them if needed.  All you need to do is to click on the item, and once 
you can see a box around the item, drag the corners or the entire box. 

 
Please note that a future publication will be dedicated to a few principles of making “attractive” maps.   
  
Incorporating Layouts with Other Documents 
There are two easy ways to incorporate your maps into other documents such as Powerpoint presentations or 
Word documents.   
 
The first involves copying and pasting.  Under the “Edit” menu, choose “Select All Elements.”  Once selected, 
you can copy (Ctrl & C), and paste (Ctrl & V) in another document.  
 
Alternatively, you could export the layout and insert it in the other document you are working on.  To do that: 

1. Select “Export Map…” in the “File” pulldown menu. 
2. Identify the file path to where you would like to save the file.  Then, identify a file type for saving.  Each 

type will have slight differences in appearance as an image.  For instance, compared to a JPEG 
formatted image, an EPS formatted image will have sharper lines and darker features and can be 
rescaled to any size, without loss of image quality.  You may want to save the layout in multiple formats 
and check for your visual preferences, file size, and end use requirements. 

3. Finally, you can bring this image in another document by inserting it (command found under “Insert” 
pulldown menu within Microsoft products).  Resize the image as needed.   

 
 
Author’s note: The steps described above utilize ArcGIS 9.1.  You may need to perform slightly different steps 
for different versions of ArcGIS.   
 
 
Aslı Göçmen is an Assistant Professor and UWEX GIS Specialist at the UW – Madison Department of Urban 
and Regional Planning.  She can be reached at: gocmen@wisc.edu or 608-265-0789 
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